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iSeriesIBM serverNotes:

Management Central uses the basic system operations on each of the endpoints (e.g., APIs for performance 
monitoring, system commands, etc.).  

PC  
the graphical interface (i.e., view) both input and output of management activities 
only needs to connect to the central system

Central System connects to other systems (called endpoints).
Accepts user input and directs all systems (called endpoints) on what do to (e.g. coordinates all activity)
Location where information on activities is stored

Endpoint system
iSeries and AS/400e systems Managed by the Central System

Management Central - Overview
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iSeriesIBM serverNotes: Management Central - Overview
The "real-time" Monitoring function is a component of Management Central  support of Operations Navigator.  
Environment

Accessing any system directly will usually be performed through the Environment (e.g.: My Connections), which is a 
container of your direct AS/400 connections.
Use of "Configuration and Services" from the Environment, would require signing on to the Central System.

Endpoint system 
Defined on the central system for the purpose of performing Management Central functions.  An endpoint system 
must be connected to the central system and must be running OS/400. The level of OS/400 that is running on the 
endpoint system determines which Management Central functions are available on that system.  The endpoint 
system cannot be running a release of OS/400 earlier than V3R1.
To add or delete a Management Central endpoint system, you must have *IOSYSCFG special authority. 

Central System
The central system stores all Management Central data and connects to the AS/400 endpoint systems. The central 
system must be a system that is connected through Client Access, accessible through TCP/IP, and running OS/400 
V4R4 or later. To use a particular AS/400 system as your central system, you must have authority to use 
Management Central on that system. Authority is controlled by the Application Administration function in Operations 
Navigator.

Operations
Ensure that Management Central support is activated on every machine in the Management Group (Central System 
and  Endpoint Systems)

< Environment >> <system-name> > Network > Servers > TCP/IP  .... Management Central
e.g.: My Connections > AS01 > Network > Servers > TCP/IP  .... Management Central

Any one of the systems in the Management Group can be designated as the Central System.
To use Management Central support, you must have the same user-id and password on Central System as well as 
all Endpoint systems to be managed.

If you do not have this setup correctly you may see the message  "The Management Central endpoint system  
'<system-name>' cannot be contacted".
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Management Central Monitors can display:
Real time performance data

Available since V4R4 
Graph performance data

New with V5R1
Interface with PM/400

System Monitoring (Real-time)

Monitor Parameter

New
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iSeriesIBM serverNotes: System Monitoring (Real-time)

The following multithreaded jobs support Real-time Monitors and the Collection Services functions of Management 
Central.

Start Management Central
QYPSSRV job in QSYSWRK subsystem

Start Real-time Monitor or Collection Services
QYPSPFRCOL   job in QSYSWRK subsystem.

Note: Time Zone Considerations - If your systems controlled by Management Central are located in different time zones, 
you must ensure that not only that your system values controlling system date (QDATE) and time (QTIME) are set 
correctly, but also that the system value for Coordinated Universal Time Offset (QUTCOFFSET) which reflect the time 
difference from GMT (Greenwich Mean Time), is set correctly.   The impact of changes resulting from transition to and 
from daylight saving time must also be considered. 
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iSeriesIBM serverNotes: Create System Groups
Before using Systems Groups with Management Central, the groups must be created.  In the creation of System Groups, 
you will also specify how data collected in monitoring can be shared with other users.

Sharing Collection Data
The following the sharing options available for each Collection Services Task.  The owner has specified one of the 
following levels of sharing:

None: Other users cannot view this item.  
Read-Only: Other users can view this item and use it.  Other users can create a new task, definition, or system 
group based on this one and make changes to the new one as needed.  However, other users cannot change this 
task, delete it, or stop it when it is running.  
Full: Other users can change and delete this item.  Other users can also view this item and use it to create a new 
task, definition, or system group.  
Controlled:  Other users can start and stop this item. Only the owner can change the level of sharing. Other users 
can also view this item and use it to create a new item based on this one. (Appears when you select Properties from 
Management Central > Task Activity > Collection services)
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Management Central > Monitor > System
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iSeriesIBM serverNotes: System Monitoring (Real-time)
To access the Real-time Monitoring facility

Open Management Central > Monitors > System

To create a new Monitor
Right-mouse click on the "System" icon
Select "New Monitor"

To modify an existing Monitor
Right-mouse click on the select the Monitor
Select "Properties"

Properties specification are now defined in 4 tabs (compared to 3 tabs in V4R5):
General - contains only the Name and Description prompts. V4R5 included the metric selection
Metrics - allows you to select the performance metrics you want to monitor.  A set of "sub-tabs" provides for the 
specification of additional collection/graphing parameters like collection interval, maximum graphing value and 
display interval.  These secondary parameters were located in the "metrics" tab in V4R5. 
Actions -similar to VR5.
Systems and Groups - this is a new tab in V5R1 which allow you to select from a list of endpoint systems, or a 
group(s) of endpoint systems.  In V4R5 the option to select the systems were presented when the monitor was 
started. 
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iSeriesIBM serverNotes: Monitor Parameters (General/Metrics)
Metrics

CPU Utilization
Average - Percentage utilization of total CPU 
capacity. in a time interval.
Interactive

Jobs - Percentage of Total CPU used by 
interactive (5250-like) jobs
Feature - Percentage of Total Interactive 
Capacity used by interactive (5250-like) jobs

Database Capability- Percentage of CPU used 
by DB2 UDB for iSeries activity 
Secondary Workloads - used on dedicated 
servers like the Domino Dedicated Server, to 
identify non-Domino workload. 
Basic - Similar to "average" but detailed job-level 
information is not collected. 

Interactive Response Time - for 5250-like 
interactions. 

Average 
Maximum 

Transaction Rate
Average - number of all interactions with system.
Interactive - number of 5250-like interactions.

Batch Logical Database I/O 
Average - Logical DB I/Os performed by batch 
jobs

Disk Arm Utilization
Average - over all  install disk drives.
Maximum - utilization of busiest disk drive.

Disk Storage
Average
Maximum

Disk IOP
Average
Maximum

Communications IOP
Average
Maximum

Communication Resources
Lines

Average
Maximum

LANs
Average
Maximum

(Memory) Pool Faults
Machine Pool
User Pools

Average
Maximum
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iSeriesIBM serverNotes:Monitor Parameters (Actions/Systems)

Actions for all metrics -Indicates which actions are to occur when a threshold is triggered or reset. Choices are:  

Log event
Adds an entry to the Event Log on the central system indicating that the threshold was triggered or reset.  The 
entry also includes the date and time the event occurred, the endpoint system being monitored, the metric being 
collected, and the monitor that logged the event.

Open event log
Displays the Event Log, which is a list of threshold trigger and reset events that have occurred.

Open monitor
Displays a graphical view of the metrics as they are being collected.

Sound alarm
Sounds an alarm on the PC.

Systems and Groups - allows you to select endpoint systems or previously grouped endpoint systems to be 
monitored by this Real-time Monitor specification.
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iSeriesIBM serverNotes: System Monitor (Real-time)

To start a Real-time Monitor
Double click on the selected Monitor or
select the Monitor and select the Green Arrow

When a Real-time Monitor is started, there are new threads associated with the monitor in the QYPSPFRCOL and 
QYPSSRV (and in QYPSJSVR) jobs in QSYSWRK subsystem..

The Monitor Profile can be changed easily through the "Properties" option of the Monitor, even while the Monitor is 
active.

When a Monitor is defined and started, you would specify the performance metrics that you would like to view in the 
monitor.  However, if you were to change the metrics, the new selection of metrics will be displayed.  Depending on 
the metrics selected for monitoring, information on additional associated metrics, may also be available for 
monitoring.  Metrics are grouped in to  "categories".  Collecting one metric in a "category" will result in all the other 
metrics in the group to be collected.  Also, the information collected (and therefore available for monitoring) is 
dependent on all the metrics started by all users of the facility.   

If the monitor window is closed, the monitor is not stopped.  If you wish to end the monitor, go to the Operations 
Navigator session, and end the monitor.
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iSeriesIBM serverNotes: System Monitor-Display 

Actions on a Job
In V5R1 the context menu for jobs in the second level data panel (and a new Job Menu item) will be enhanced to 
provide access to all of the functions available on a job.  In other words, the context menu on a job in the graph will 
now include such options as Hold, Release, Open Files, etc. These actions will be the same as those available for 
the Job monitor.
Windows Layout
For V5R1 this layout has changed in the following ways:

Windows can be tiled in 1, 2, 3, or 4 columns
When a user moves a window, all of the windows remain in a tiled fashion, and the moved window  'pops' into the 
new location in between the windows that it was placed next to.  The windows will move to the right, and then 
move down to the left to remain in the number of columns specified.  This behavior is similar to how the Lotus 
Notes databases move (with the exception that the Lotus databases don't move down to remain in a set number of 
columns).
When a metric is minimized, the window will move down to the end of the first level data, and the other windows 
will move around, to fill the space of the minimized window.  The movement will be from bottom to top, and right to 
left (in the opposite way that they move when a window is inserted).
When a minimized window is restored, it moves to the bottom of the open metric windows.

New Zoom Function
A new zoom function will be added to the system monitors in V5R1.  Normal will be considered the value of the 
Display Time that the user selected for the metric.  The user can now zoom using three methods:

Zoom options in the View pulldown
Clicking new Zoom buttons
Dragging the mouse and making a Marquee selection on the graph
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Actions available on a job

hold, release, open files, etc.
window layout
zoom features

From File pulldown
Graph History

For this Collection
Trend Analysis

Access PM/400 web site
Export Data Option

Comma Separated Variables (.csv)
Lotus 1-2-3 compatible (.csv)
ASCII Tab Delimited Text (.txt)
Microsoft Excel 97 (.xls)
Web Page(.html)

One hour's data kept after monitor stopped

Collection

Summarized
real-time

Monitor

Graph History

New

New
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Performance Management/400 Link
A new option will be available from the File pulldown that will launch a web browser to the PM/400 web site.  From 
here a customer can login and obtain PM/400 reports on his system.

Other Enhancements
An hours worth of data is now kept even after a monitor is stopped.  Thus, if a monitor is stopped and then restarted 
(and no other monitor is collecting those metrics) the monitor will display a line representing the data collected prior 
to the monitor being started.  The line will not be connected to any new data coming in since there was a gap in the 
actual data collection.
A new status of 'Stopped - collecting for system only' will be added for the 'Status' field on the Collection Services 
Property General page.  Changes made to collection services in V5R1 make it possible for collection services to be 
stopped and no longer collecting any information for the user, but the collection service object may still be collecting 
information for other services such as PM/400.  Therefore, if the user selects the 'Stop collecting' option for collection 
services, but PM/400 is running, they will get this new status.  If no other services are running, the status will be 
'Stopped'.

The Collection Services Status panel for an endpoint system will also show the new 'Stopped - collecting for 
system only'.
The Collection Services Status panel for a group will continue to show 'Stopped' status as the aggregated status, 
but the individual systems will use the 'Stopped - collecting for system only' status.
Along with the new status, the Collection Profile of 'None' will be removed from the Collection Profile dropdown of 
the Data to Collect page on Collection Services.
On the Start Collection Services General page, the first control 'Cycle if already started' was changed to 'Cycle if 
already collecting'.  This change was made to be more consistent with new status of Stopped - collecting for 
system only.

Note: For a Collection to stop, all activations of the collection must be ended, by each user.
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Graph Data

Graph "handles" allow 
to expand and reduce 

x-axis.
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iSeriesIBM serverNotes: Graph Data
The amount of data that is available for graphing is determined by the settings chosen in the Collection Services 
properties.  Also, if Performance Management/400 is not started on a system, no more than 7 days of data can be 
displayed.  If PM/400 is started, the user will immediately be able to view a total of 30 days of history.

In many cases the data that is graphed will not be a one to one correspondence with the data that was collected.  For 
example, if data was collected on a 60 second basis, but the user chose to view data for the last month with an interval 
of day, the graphed data points will represent an average of the data that was actually collected.  If the retention period 
was set such that 'Graph data' was kept for 30 days, the user could still select a data point and second level data would 
be calculated.  The top 20 jobs for a particular day would now be shown in the second level data.

Additional features:
Drill-down capability.  Data points for the graph will be represented by three different graphics representing the three 
levels of data that are available.

       A square will be used when the data includes both second and third level information (in other words it is just 
like the System Monitors and should use the same graphic)
       A triangle will be used to represent summarized data that has second level information (in other words 
selecting this point will display second level information that is summarized.
        A circle will be used to represent data that contains no drill down information.

Select date/time range 
viewing graphs

zooming in/out
change viewed metrics

Exporting data 
(egg: for printing)

Prerequisite
Data Summarized (real-time)
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iSeriesIBM serverNotes: Job Monitor - General
You can use a job monitor to monitor a job or list of jobs based on job name, job user, job type, subsystem, or server type. 
For example, you might want to monitor a job's CPU usage, job status, or job log messages. The job monitor allows you to 
define commands to run when a specified threshold is met.  

You can select the servers from a list provided. A few examples of these servers are:
AS/400 WebFacing Server

The AS/400 WebFacing server gives a Web-based application access to application data from interactive programs 
running on the AS/400 system.

Domino Server
Domino is a product that runs on a variety of platforms and provides easy to manage inter-operability in a 
heterogeneous network. The Domino server provides functions that include e-mail, work, flow-based computing, and 
the integration and management of both structured and unstructured data.

HTTP Server
The AS/400 HTTP server allows you to serve multimedia objects, such as hypertext markup language (HTML) 
documents, to World Wide Web browser clients with your AS/400 system.

Wireless Server
The Wireless Connection for AS/400 (5798-TBW) server is used to connect wireless mobile 5250 hand held devices 
(PTCs) to the AS/400. This server job uses a selected TCP interface that must be started prior to this server.

WebSphere Administration
The AS/400 WebSphere Administration server allows a WebSphere user to connect a WebSphere Administrative 
Console to the AS/400 to administer the WebSphere configuration.

Extended Dynamic Remote SQL
The Process Remote Extended Dynamic SQL (QxdaProcessExtDynEDRS) API is used to perform extended dynamic 
SQL operations on the database server system. The SQL operations are performed by the Process Extended 
Dynamic SQL (QSQPRCED API). For more information, see the Process Extended Dynamic SQL (QSQPRCED) API 
documentation.
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New
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iSeriesIBM serverNotes: Job Monitor-Metrics

For a job monitor, available metrics include job count, job status, job log messages, CPU utilization, logical I/O rate, 
disk I/O rate, communications I/O rate, transaction rate, and more.  The job monitor allows you to define commands 
to run when a specified threshold is met.
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iSeriesIBM serverNotes: Message Monitor

For a message monitor, you can specify one or more message IDs, message types, severity levels. You can also 
select from a list of predefined sets of messages that would be associated with a specific type of problem, such as a 
communications link problem, a cabling or hardware problem, or a modem problem.

You can permanently remove monitored messages from message queue, or you can also choose "trigger at the 
following message count" to specify AS/400 message count trigger and reset commands.

There are two message sets, which are independent of each other and provide a way to monitor for different 
conditions in one monitor. For example, you may monitor for a less severe condition and send a command to page 
the system operator or you may monitor for a more severe condition and send a command page to start ending 
certain jobs.
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OS/400 commands can be setup to execute when the Trigger or Reset threshold values has been reached.  The 
commands are provided with full prompting capability.
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Start Collection Services 
Single Endpoint

Management Central > Endpoint Systems> <system-name> > Configuration and Services > Collection Services
System Group

Management Central >  Systems Group> <group_name> > Configuration and Services > Collection Services
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iSeriesIBM serverNotes: Collection Services (Performance )

To Start Collection Services on a single Endpoint System:
Management Central > Endpoint Systems> <system-name> > Configuration and Services > Collection Services

To Start Collection Services on a Group of Systems:
Management Central >  Systems Group> <group_name> > Configuration and Services > Collection Services

Ensure that you have defined the Endpoint Systems in the System Group 

Use of Collection Services requires the installation of Management Central support of Operations Navigator.

You must have the same user-id and password on Central System as well as all Endpoint systems to be managed.
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 V4R5
V5R1

New

New

New
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General:

Collection Services does not provide an option to change the library name for the data.
If PM/400 is active, the data is stored in Library QMPGDATA. 
If PM/400 is not active, , the default library is QPFRDATA. 
 However, it is possible to change the library name through the Change System Collector Attribute API (QYPSCSCA).  
Starting Collection Services through a 5250-session also allows you to change the collection library.

Collection retention period:
The length of time that collection objects remain in the file system before they are deleted. You can get maximum use from  
the collection retention period if you enable Performance Management/400.
The status field for Performance Management/400 indicates whether PM/400 is started (Started), is not started (Stopped), or if 
there was a problem (Failed). To start PM/400, select Start Performance Management/400.

Detailed data
The length of time that collection objects remain in the file system before they are deleted. You can select a specific time 
period in hours or days, or you can select Permanent.  If you select Permanent, the collection objects will not be 
automatically deleted.

Graph data
The length of time that the data for the details and properties data that are shown in the Graph History window remain in 
the system before they are deleted. If you do not start Performance Management/400 (PM/400), you can specify one to 
seven days. If you do start PM/400, you can specify one to thirty days. The default is one hour. 
Note: The Graph data field is not available to central systems or endpoint systems that do not have Version 5 Release 1 
Modification 0 or later (V5R1M0) installed.

Summary data
The length of time that the data points of a graph can be displayed in the Graph History window or remain in the system 
before they are deleted. No details or properties data is available. You must start PM/400 to enable the summary data 
fields. The default is one month. 
Note: The Summary data field is not available to central systems or endpoint systems that do not have Version 5 Release 
1 Modification 0 or later (V5R1M0) installed.
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Collection Profiles

Minimum
Standard
Standard plus Protocol
Enhanced Capacity Planning

Additional Categories:
Extended Adaptive Cache Simulation
PEX Data - Processor Efficiency

Included with Enhanced Capacity Planning    

New

New
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iSeriesIBM serverNotes: Collection Services (Data to Collect)
The following options are available for performance data to collect under Collection Services:

Since V4R4
Standard
Standard plus Protocol and 
Custom (user selected metrics)

New with V5R1
Enhanced Capacity Planning

Includes PEX Trace - Processor Efficiency.  Statistics for this were collected new during V4R5 using the OS/400 
command STRPFRMON INTDTA(*YES) parameter.  Since STRPFRMON is no longer supported in V5R1, this 
option has been added to Collection Services. If collected, BEST/1 uses this data in its workload modeling, varying 
its algorithms for growth analysis based upon the efficiency statistics.

New TCP/IP metrics are included in any communications protocol metrics.
Extended Adaptive Cache Simulation has been available since V4R4, but require the appropriate Disk Unit Controller to 
be installed as its microcode actually does the simulation.  The simulation projects reduction in Disk I/Os and Disk 
Response time if the Disk Unit Controller has the actual 1.6 GB Read Cache device feature was installed on the Disk Unit 
Controller and running the same workload recorded under Collection Services.  

Based upon the projected percent improve a decision to order and attach the Read Cache Device would be made.
Disk Unit Controllers supporting Extended Adaptive Cache Simulation include:

7xx, 170, 250: 2748 PCI RAID Disk Unit Controller
270, 8xx: 4748/9748 PCI RAID Disk Unit Controller

The 1.6 GB Read Cache device features are:
7xx, 8xx: #4331
170, 250, 270: #6831
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iSeriesIBM serverNotes: Collection Services-Scheduled Task 
If you click on the "Schedule" button, the 
Management Central Scheduler  panel will display.  
This allow you to specify a schedule against which 
the Collection  Services task will run.

If your system has Advanced Job Scheduler 
(5722-JS1) installed, then a screen associated with 
this product will be displayed, which gives you 
greater flexibility to schedule the collection services 
task.
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New
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iSeriesIBM serverNotes: Collection Services - Task Activity

Selecting Collection Services within the Task Activities container will show the scheduled tasks for this function.

Select any task that you need more information on.  For example, if the task has failed, the "Status" option in the 
pulldown menu will give you more information on the cause of the failure.
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Collect Performance Data M01
02/16/01 09:59:10

Collection Services status:
Status . . . . . . . . . . . . : Stopped

Select one of the following:

1. Start collecting data
2. Stop collecting data

Selection or command
===>

F3=Exit F4=Prompt F5=Refresh F9=Retrieve F12=Cancel

Collection Services - 5250

Start Collecting Data

Type choices, press Enter.

Library . . . . . . . . . . . . . . PFRV5R1CS Name
Collection interval (minutes) . . . 5.00 0.25, 0.5, 1, 5, 15, 30,

60
Retention period:

Days . . . . . . . . . . . . . . . *PERM *PERM, 0-30
Hours . . . . . . . . . . . . . . 0 0-23

Cycling:
Time to synchronize cycle . . . . 02:00:00 HH:MM:SS
Frequency to cycle collections . . 24 1-24

Create database files . . . . . . . *YES *YES, *NO
Collection profile . . . . . . . . . *STANDARDP *MINIMUM, *STANDARD,

*STANDARDP, *ENHCPCPLN

F3=Exit F12=Cancel

New
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iSeriesIBM serverNotes: Collection Services-5250

Collection Services can be started and stopped from a 5250-session. 
 

From the main Performance Tools Menu (GO PERFORM or STRPFRT) select option-2.
The Start option allows you to specify a Library to locate the performance collection object.
The collection object has the following characteristics:

Name:  Q<Julian-date-time>  
Type: *MGTCOL   
Attribute:  *PFR 

Note: The library to contain the collection object can be specified here and it would override the default values of 
QPFRDATA or QMPGDATA.  

If PM/400 is active, QMPGDATA  is the default library.  Also, if PM/400 is active, and collection services is not 
started, it will restart collection services, based on the time indicated in  Q1PPMSUB , which time is incremented 
every hour. 
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Data
Summarized

New
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iSeriesIBM serverNotes: Graph Data - Collection Services
Past Collection Services output  can be also used to generate Graphs ("Graph History").

Prerequisite - The collection must be Summarized.  The summarization process 
generates a Data Queue (*DTAQ) in the same library as the collection. 
The graph produced is for each collection only.
If a Trend Analysis is required over multiple collection periods, facilities offered by PM/400 
must be used.   

Collection

Summarized
(batch)

Graph Data
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Supported File Types

Comma Separated Variables (.csv)
Lotus 1-2-3 compatible (.csv)
ASCII Tab Delimited Text (.txt)
Microsoft Excel 97 (.xls)
Web Page(.html)
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iSeriesIBM serverNotes: Export Data
The current  monitor does not support printing. However, with the new capabilities to view historical data, it is 
important to allow the customer to obtain a printed version of the graph.  We would like to support a print option.  
However, because of resource constraints, an Export function for the Graph History function would be sufficient in 
the short term. 

The export function would only export what was shown in the graph, it would not export all of the data for time 
periods outside of what is displayed. 

You could manage the retention of output from collection services, using the retention period as "permanent".  The 
Graphing/Export capability can then be used to transfer data in to Lotus or Excel spreadsheet.  The data then can be 
manipulated to build your own Trend Analyses over multiple collection period too. 
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iSeriesIBM serverNotes:Create DB Files (Performance Tools)
Use the Create DB Files option to generate tables for use with Performance Tools (5722-PT1).

Regardless of which library (QPFRDATA, QMPGDATA mainly) contains the performance data collections from V5R1 
Collection Services, the Performance Consultant can determine which library is to contain the Database Files (for use 
with Performance Tools) are to be created.  

When creating the Database Files, the user can specify the start/end times and dataset names of the data to be 
placed in the library. 
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iSeriesIBM serverNotes:
Starting in V4R5, administrators have even more flexibility in how they access and interact with their iSeries using 
Management Central - Pervasive. New capabilities have been added in V5R1 so the suite of Pervasive functions now 
include System Availability, Monitors (system, job and message) and Commands using an Internet phone, a personal 
data assistant (PDA) with a wireless modem, or a traditional web browser on a workstation. 

The Central System and the associated Endpoints are managed by the standard Management Central Support of 
Operation Navigator.  For the functional extensions of MC-Pervasive, the additional requirements are at the Central 
System and "upstream" of the Central System.

The web application server on the central system will have to be configured or setup to provide the necessary level of 
security. Set up the web application server to implement the protection plan developed to provide proper authentication 
security based upon your client devices, browsers and network. IBM recommends implementing HTTP with SSL 
(HTTPs) whenever possible.
In order for the servlet to be able to send back the bitmap, the HTTP server must know where it is located, and it must 
know how to handle bitmap files. In order to access the HTTP configuration, go to the 2001 port on the system running 
HTTP. Under the HTTP configuration you will need:
Request processing -> Request routing

Action:  Pass
V4R5

URL Template:  /McYpvPervasive/*
Replacement file path:  /QIBM/ProdData/OS400/*

V5R1-NLS
URL Template:  /McYpvPerv/*
Replacement file path:  /QIBM/ProdData/OS400/MGTC/Pervasive/*

V5R1
URL Template:  /McYpvPervasive/*
Replacement file path:  /QIBM/ProdData/OS400/MGTC/Pervasive/*

MC - Pervasive (Introduction)
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OS/400 Requirements
To take advantage of the MC-Pervasive enhancements of V5R1, the Central System requires V5R1 OS/400 with 
Management Central - Pervasive PTFs.  This provides the code which enables the existing Management Central 
performance monitors to interact with other application servlets (e.g.. those  which will feed the information back to a 
phone or browser).
Web Application Server on Central System 
Because Management Central-Pervasive requires the services of a Servlet engine, you must install and configure a 
web application server which has the capability to host servlets (McYpvPervasive servlet for MC-Pervasive) for serving 
Internet information.  The following servers have been tested by IBM:

WebSphere Application Server 3.02 Standard Edition
WebSphere Application Server 3.5 Standard and Advanced Edition
Domino Application Server

Pervasive User Devices
Internet-enabled Phone
PDA (personal data assistant) with a web-browser, wireless modem 
Traditional web-browser on a PC workstation

A wireless Internet service is required in all cases (this is what transports the data to/from your "pervasive device" and 
the Central system - it may not be the same as your voice service!).
Firewall
When you use Management Central - Pervasive, you will be accessing at least one of your systems from the Internet.  If 
you access any of your systems from the Internet today, you probably have a firewall set up to prevent unauthorized 
access. Depending on your firewall configuration, you may have to modify your firewall setup to run MC - Pervasive.  
If you have never accessed your systems from the Internet and do not have a firewall setup, the following IBM Redbook 
provides strategies for doing so in Chapters 8 and 9.  See AS/400 Internet Security Scenarios: A Practical Approach, 
SG24-5954-00.  IBM Redbooks can be found online at www.redbooks.ibm.com.

MC - Pervasive (Overview)
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MC Pervasive PTFs 

For V4R5:
SF62901
SF64097

For V5R1
To Be Determined

Authorize User Profile 
(QEJBSVR for WebSphere: QNOTES for Domino) 
Use Authority

 QSYS/QYPVJNI *SRVPGM 
Read authority to the directory 

V4R5: /QIBM/ProdData/OS400
V5R1: /QIBM/ProdData/OS400/MGTC/Pervasive

Read/write authority to the directory 
V4R5: /QIBM/UserData/OS400
V5R1: /QIBM/UserData/OS400/MGTC/Pervasive
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MC Pervasive PTFs 

For V4R5:
SF62901 and SF64097

For V5R1
o Be Determined

After installing the PTFs, you will need to move the MC - Pervasive Java programs to the appropriate location.  
Typically this would be done by using the command, RST DEV('/QSYS.LIB/QYPVPERVSF.FILE') 
OBJ(('/QIBM/PRODDATA/OS400/*')).  However, the OBJ value shown can be changed depending on your web 
application server setup. 
User Connection Profile
Ensure that you give the necessary authority (*use) to the object QSYS/QYPVJNI *SRVPGM to the user profile 
running the McYpvPervasive servlet (for WebSphere QEJBSVR: for Domino=QNOTES), and:  

Read authority to the directory 
V4R5: /QIBM/ProdData/OS400
V5R1: /QIBM/ProdData/OS400/MGTC/Pervasive

Read/write authority to the directory 
V4R5: /QIBM/UserData/OS400
V5R1; /QIBM/UserData/OS400/MGTC/Pervasive

Also, users of MC-Pervasive require Read/write authority to /QIBM/UserData/OS400/MGTC/Pervasive.
The servlet accesses text files (QYPVxxxxxxxx.txt where xxxxxxxx is the user id) in this directory. This text file has a 
list of endpoint systems the user requires to view.  A default list of endpoints can be included in 
QYPV_SYSTEMS.txt.  When a user connects to the central system via the web applications server, the MC - 
Pervasive servlet will attempt to locate a user specific or custom list of endpoint systems.  If the file does not exist, it 
will look for the default connection profile. If neither is found, a custom connection profile will be created for the user to 
update using phone, PDA or browser. 
Note: Refer to the Management Central - Pervasive User's Guide for more information.
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WebSphere Application Server:
You must add the two jar files used by the MC - Pervasive servlet to the web application server.  For example, when using 
WebSphere, 

Open the WebSphere Administrative Console
Select the Topology tab
Select the application server that will be running the MC - Pervasive servlet

Add the following classpath information to the command line arguments parameter:
(V4R5) -classpath 

/QIBM/ProdData/OS400:
/QIBM/ProdData/OS400/mcypvperv.jar:
/QIBM/ProdData/Http/Public/jt400/lib/jt400.jar 

(V5R1) -classpath 
/QIBM/ProdData/OS400/MGTC/Pervasive:
/QIBM/ProdData/OS400/MGTC/Pervasive/mcypvperv.jar:
/QIBM/ProdData/OS400/MGTC/McClient.jar:
/QIBM/ProdData/OS400/MGTC/McOSClient.jar:
/QIBM/ProdData/OS400/MGTC/McPrivServer.jar:
/QIBM/ProdData/OS400/MGTC/mcyrmcom.jar:
/QIBM/ProdData/OS400/jt400/lib/jt400Native.jar:

Then press apply.
Note:  After changes to the classpath, you must stop and start the server instance for the change to take effect.
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JVM uses the following values to determine time of day
QUTCOFFSET

Set OS/400 system value QUTCOFFSET
LOCALE

Ensure that the associated Locale information is revised
Change the source file
Create the Locale object (CRTLOCALE)

Set the following values:
Set the Language environment variable to the locale: 

ADDENVVAR LANG '/qsys.lib/qgpl.lib/en_us.locale'
(or QSH,  export -s LANG=/qsys.lib/qgpl.lib/en_us.locale)

Set the user profile to be used to the desired locale. 
CHGUSRPRF USRPRF(QEJBSVR) LOCALE('/qsys.lib/qgpl.lib/en_us.locale')

Set system value QLOCALE 
CHGSYSVAL SYSVAL(QLOCALE) VALUE('/qsys.lib/qgpl.lib/en_us.locale')
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Time Considerations: 
If time is not shown correctly on a PDA or browser,  PTF SF63718 will correct the problem where WebSphere does 
not pick up the correct locale setting from the Java Virtual Machine (JVM).  
The JVM uses both the QUTCOFFSET and the current LOCALE to determine local time. If both are set to zero, 
things work fine. By default, the time zone and time offset information in each locale is, by default, set to 0. This 
means that as soon as the QUTCOFFSET gets set on the system, java time returned becomes incorrect. 
Default *LOCALE objects are shipped in QSYS. These objects all have default time zone information of 0. i.e. GMT.  
Use " WRKOBJ OBJ(QSYS/*ALL) OBJTYPE(*LOCALE)" to view all the shipped locales.  The Locale source files are 
shipped in QSYSLOCALE/QLOCALESRC.  To set time zone and other information, copy and edit the local source for 
the particular time zone you're supporting. 
Example LC_TOD section for an EN_US locale. 

tzdiff   -300 (number of minutes difference from GMT)
tname    "<C><S><T>" (Time zone name)
dstname  "<C><D><T>" (daylight savings time name).
dststart 4,1,1,7200  (DST Start in this part of the US is the first Sunday in April at 2am)
dstend   10,-1,1,7200 (DST End in this area of US is Last Sunday in October)
dstshift 3600 (shift in seconds)

Create the new locale object for that time zone using the following. Use a CCSID that matches the same shipped 
OS/400 local as the one you're creating. (DSPLOCALE QSYS/EN_US) 

CRTLOCALE LOCALE('/qsys.lib/qgpl.lib/en_us.locale') SRCFILE('/qsys.lib/qgpl.lib/qlocalesrc.file/en_us.mbr') 
CCSID(37)

For help on internationalization, see the locales section at: 
http://publib.boulder.ibm.com/cgi-bin/bookmgr/BOOKS/QB3AQ501/CCONTENTS 

0555.00 LC_TOD                              
0556.00                                     
0557.00 tzdiff   -360                       
0558.00 tname    "<C><S><T>"                
0559.00 dstname  "<C><D><T>"                
0560.00 dststart 4,1,1,7200                 
0561.00 dstend   10,-1,1,7200               
0562.00 dstshift 3600                       
0563.00 
0564.00 END LC_TOD                  
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Central System URL
Enter the URL of your central system on your wireless device. 
Use the following format, and make sure that the end of the URL (/servlet/McYpvPervasive) is entered exactly as 
shown:

<host>.<domain>:<port>/servlet/McYpvPervasive 
host: The host name of the central system
domain: The domain the central system is located
port: The port that the MC - Pervasive servlet is listening to

User Connection Profile
When the user connects to the central system via the web applications server, the MC - Pervasive servlet will attempt 
to locate a user specific or custom list of endpoint systems.  If the file does not exist, it will look for the default 
connection profile.  At the point which neither is found, a custom connection profile will be created for the user to 
update using phone, PDA or browser.

How It Works!
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V4R5
Monitor 

iSeries System Status
Performance

V5R1
Monitor/Control Specific Jobs or Servers
Monitor Message Queues
Execute Commands
Manage Integrated xSeries Servers
Support for Additional Phone Devices 
Read only mode for selected users

Functions Overview
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Monitor Performance 

View real-time performance metrics (V4R5)
Check against thresholds (V4R5)
View top 20 jobs contributing to each metric, and review related details
Start/Stop monitors

Monitor Specific Jobs 
View job-level and summary-level metrics in real-time
Check for jobs with  triggered events

Monitor Message Queues 
View message details, reply to message, delete message
Start/Stop monitors
Hold, Release or End a Job on any Endpoint System

Run Commands on any Group of Systems
Choose from your predefined list of MC commands
Enter the command from the device
View distributed task status

Manage Integrated xSeries Servers
View status of IxS servers
Startup/Shutdown servers
Run NT commands
Monitor IxS events (routed to an iSeries message queue)

Read Only mode for selected Users

Functions Overview
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NLS Enabled
Required PTFs for OS/400 (5722-SS1)

 TBD - ????
Functions

System availability
Monitors

System
Language support

Set the Language_Country and characterset for a PC Browser
http://sysname:port/servlet/McYpvPerv?LNG=lang

where 'sysname' is your central system name
where 'port' is the port your servlet is configured
where 'lang' is the language (Lang_Country)

New
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In V5R1, the servlet McYpvPerv provides NLS enablement support for the Pervasive function delivered in V4R5.

The Supported Languages with their browser settings for Language_Country and characterset are:
Language             Lang_Country Characterset Language             Lang_Country Characterset
Chinese Simplified zh        gb2312 Hungarian            hu        iso-8859-2
Chinese Traditional zh_TW big5 Italian                 it        iso-8859-1
Croatian                hr        iso-8859-2 Italian Swiss     it_CH     iso-8859-1
Czech                   cs        iso-8859-2 Japanese                 ja        shift-jis
Dutch                   nl        iso-8859-1 Korean     ko        euc-kr
Dutch Belgian nl_BE     iso-8859-1 Polish        pl        iso-8859-2
English                 en        iso-8859-1 Portuguese        pt        iso-8859-1
French                  fr        iso-8859-1 Portuguese Brazilian pt_BR     iso-8859-1
French Belgium    fr_BE   iso-8859-1 Romanian             ro        iso-8859-2
French Canadian     fr_CA     iso-8859-1 Russian              ru        indows-1251
French Swiss    fr_CH    iso-8859-1 Slovakian             sk       iso-8859-2
German     de       iso-8859-1 Slovenian           sl        iso-8859-2
German Swiss de_CH     iso-8859-1 Spanish                es        iso-8859-1
Greek                   el        iso-8859-7

To set the Language_Country and characterset for a PC Browser
Netscape

To set Language from tool bar select Edit-> Preferences -> click on Languages (click on add button to see list of  
browser possibilities)  First one in list will be the one used.  
To set  Characterset from tool bar select: View -> Characterset

Explorer
To set Language from tool bar select Tools -> Internet Options -> click on Languages button  (click on add button 
to see list of  browser possibilities)  First one in list will be the one used.    
To set  Characterset from tool bar select: View -> Encoding  (may have to select more to see entire list)

Force language setting via URL
 Add language parameter ?lng= after url      (i.e. ?lng=zz )   where zz is  Language_Country to be used.  
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In this example, the Management Central System (AS25) is monitoring two systems 
As25 and 
As80

 using two metrics,
Average CPU Utilization - with a threshold of 80%
Batch Logical I/O - with a threshold of 2000 I/Os.

The panel on the left shows the Management Central Monitor and the panel on the right is the view through 
MC-Pervasive on a browser.  

The information shown on the browser represent a time-stamp of 12:32pm at which time there was almost no activity 
on As80 and the activity on As25 was below threshold levels.  
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In this example, the Management Central System (AS25) is monitoring two systems 
As25 and 
As80

 using two metrics,
Average CPU Utilization - with a threshold of 80%
Batch Logical I/O - with a threshold of 2000 I/Os.

The panel on the left shows the Management Central Monitor and the panel on the right is the view through 
MC-Pervasive on a browser.  

The information shown on the browser represent a time-stamp of 12:08pm at which time there was very high CPU 
activity on As80 causing it to exceed the threshold value set in the monitor.  Accordingly, the browser indicates  that 1 
of the thresholds have been triggered (A). There is also a flag on As80 showing "Triggered" corresponding to the 
96% CPU usage on this system. 

The activity on As25 is below threshold levels.  
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V5R1:
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System
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Job details and control
Command

Results
Enter command 

Improved Navigation

System300
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System500
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System500
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In V5R1, Management Central Monitoring support includes Job Monitoring and Message Monitoring in addition to 
System Monitoring which was available in V4R5.

V5R1 includes support for Job and Message monitoring through MC-Pervasive.  

The left-most panel shows that there are 3 systems in the Group.  When you select "Systems", it will show you the 
names of the systems (center panel).  Selecting a particular system will display information about that system, 
including IP address, Release level of OS/400 and other system details. 
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The sequence of panels are some of the screens that you will see on a browser  running MC-Pervasive, as you 
review  system operator messages based on triggers setup on Management Central.

System500 shows that a trigger has been set for message monitoring ( panel-3).    The next panel (4) shows that 
message CPI1126 has been encountered.  Panels  5 and 6 on the right show how you can drill-down to review the 
message details. 
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The sequence of panels shows some of the key screens you would navigate through in monitoring a system over 
MC-Pervasive on an Internet browser.  

Panel 1 shows the user opting to monitor CPU Utilization, followed by the selection of System500. Panel 3 shows 
that there is high CPU usage.  Drilling down in to this usage reveals that one particular job is using a significant 
portion of that CPU (panel 4) 

Panel 6 and 7 shows details of the job in question.  The user opts to terminate this job immediately (panel 7). .
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The chart shows some of the screens encountered while accessing MC-Pervasive through an Internet browser, run 
OS/400 commands.

In panel 1, the user opts to execute a command.  In the following panel (2), selects the command to run ("cleanup").  
Panel 3 identifies  the systems against which the commands are to be run are identified.  Panel 4 shows the 
successful completion of the execution of the command. 

V5R1 MC-Pervasive (Command)
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MC-Pervasive also provides support for managing the Integrated xSeries Server on iSeries.

The main Pervasive summary display on a browser,  will display all the attached  Integrated xSeries Servers on the 
particular iSeries, indicating the total number configured, including the number active and inactive (panel-1).

Selection of "Server Link"  will display details of the Integrated xSeries Servers (panel-2).  The pulldown menu will 
permit the following functions on any server:

Restart
Shut down
Run Command

For example, if the Run Command option is selected, you will be required to confirm that you want to run the 
command on all active servers (panel-3).  If the command is to run only on a specific server, you need to select the 
server before selecting the option to run a command. 

Panel-4 shows the prompt provided to key in the command to run on the Integrated xSeries Server.

Note: To run commands on INS server, user must have  same userid and password on   INS as on iSeries. 
V5R1:pervasive customer will need to visit the Pervasive web site, print/view the user guide to obtain the PTFs for 
current install/config instructions, expanded device support. (PTFs in V5R1 will put the code in the appropriate 
location.)
V4R5:In addition to above, you have to move the java programs to the appropriate location with a RST command. 
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Management Central
www.ibm.com/eserver/iseries/sftsol/MgmtCentral.htm

Management Central - Pervasive: Users Guide & FAQ
www.ibm.com/eserver/iseries/sftsol/pervasive.htm

AS/400 WebSphere
www.ibm.com/eserver/iseries/websphere

AS/400 HTTP
www.ibm.com/eserver/iseries/http

Redbook: 
AS/400 Internet Security Scenarios: A Practical Approach SG24-5954

Webpages
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Operations Navigator

Collection
5250-Session

Menu 
Option

Operations Navigator

5250-Session

Menu or
Command

Sample Data

Menu or
Command

System
Component
Job
Pool
Resource

5250-Session

Collection Services
Management Central
5250-Session

Performance Main Menu
Option-2: Collect performance data 

Create Performance Data
Management Central
5250-Session

Performance Main Menu
Option-6: Configure and manage tools

Option-5: Create performance data 
CRTPFRDTA command

Print Sample Reports
5250-Session

Performance Main Menu
Option-3:  Print performance report 
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Collection Services is used to gather Sample Performance Data.  You can either use 

Collection Services function of Management Central (Operations Navigator)  or 
Option-2 of the Performance Main Menu (GO PERFORM or STRPFRT).  

The Collection data is converted to Performance Tools tables using
Create DB Files  function of Management Central (Operations Navigator)  or 
5250-Session

Option-6 (Configure and Manage Tools) of the Performance Tools Main Menu or 

CRTPFRDTA command..

 
The CVTPFRDTA command continues to be supported to convert performance datasets from lower version/release 
levels to higher levels.  
The Print Performance Report option has two sub-menus which are supported by a Toggle Function Key (PF20) if both 
types of data are present in the same library.

Sample Reports
Print System Report (PRTSYSRPT)
Print Component Report (PRTCPTRPT)
Print Job Interval Report (PRTJOBRPT)
Print Pool Report (PRTPOLRPT)
Print Resource Report (PRTRSCRPT)

Trace Reports
Print Transaction Report (PRTTNSRPT)
Print Lock Report (PRTLCKRPT)
Print Job Trace Report (PRTTRCRPT)
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Trace
Data

Trace Data

Command

5250-Session 5250-Session
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Lock
Job Trace

Menu or
Command

5250-Session

Command

Start Trace Collection
5250-Session

STRPFRTRC
TRCINT

End Trace Collection
5250-Session

ENDPFRTRC
DMPTRC

Print Trace Reports
5250-Session

Performance Main Menu
Option-3:  Print performance 
report 

Delete Trace Collection
5250-Session

RMVM
DLTF
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There is currently no GUI interface through Operations Navigator to collect Performance Trace Data.  It can only be  
collected through  STRPFRTRC command..  The collection is stopped through the ENDPFRTRC, which also creates 
the Trace Database files. 

Additional commands: 
TRCINT - similar to STRPFRTRC
DMPTRC - similar to ENDPFRTRC

Note: When ENDPFRTRC or DMPTRC is run after trace data is collected a file member is added to QAPMDMPT.  
You will  have to use the RMVM command to remove these members, or DLTF command to delete the entire file.  
 
The CVTPFRDTA command continues to be supported to convert performance datasets from lower version/release 
levels to higher levels.

The Print Performance Report option has two sub-menus which are supported by a Toggle Function Key (PF20) if 
both types of data are present in the same library.

Sample Reports
Print System Report (PRTSYSRPT)
Print Component Report (PRTCPTRPT)
Print Job Interval Report (PRTJOBRPT)
Print Pool Report (PRTPOLRPT)
Print Resource Report (PRTRSCRPT)

Trace Reports
Print Transaction Report (PRTTNSRPT)
Print Lock Report (PRTLCKRPT)
Print Job Trace Report (PRTTRCRPT) 
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Changes to System Report (PRTSYSRPT)
DB Capability (since V4R5)
Interactive Feature (since V4R5)
TCP/IP Summary 

Select Sections for Report

Member . . . . . . . . . . . : ITSCV51_01

Type options, press Enter. Press F6 to print entire report.
1=Select

Option Section
Workload
Resource Utilization
Resource Utilization Expansion
Storage Pool Utilization
Disk Utilization
Communication Summary

TCP/IP Summary

Bottom
F3=Exit F6=Print entire report F12=Cancel

System Report

New

New
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CPU Utilization

Interactive Feature
Shows the CPU utilization for all jobs doing 5250 workstation I/O operations as a percentage of  the interactive 
capacity of the system.  Depending on the hardware features installed, the interactive capacity is equal to or less 
than the total capacity of the system.

Database Capability
Indicates the DB2 UDB for iSeries activity of the system as a percentage of the installed total capacity of the 
system.  This represents all DB activity including

SQL
Data I/O operations

TCP/IP information
Unicast - a piece of information is sent from a single source to a specific destination.  This is the predominant form 
of transmission on LANs and the Internet. Typical unicast applications are HTTP, smtp, ftp and telnet).  TCP 
(Transmission Control Protocol) supports only unicast mode. 
Non-unicast - includes broadcast and multicast communications:

Broadcast - a piece of information is sent from one source.  This could be used to send the same message to all 
computers on a LAN.(e.g.: the address resolution protocol (arp) uses this to send an address resolution query to 
all computers on the LAN). 
Multicast - a piece of information is sent from one or more sources to a set of destinations. There may be one or 
more senders, and none, one or more receivers.  (e.g.: a video-server sending networked TV channels.  The 
same packet of information is delivered simultaneously to many clients.)  Multicast applications must use UDP 
(User Datagram Protocol) transport protocol.

The values indicate packets delivered or received by the specific interface from a higher-layer protocol.

Note: Some TCP/IP information maybe lost if TCP/IP support is started/stopped during data collection.
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Changes to Component Report (PRTCPTRPT)
TCP/IP Activity
Terraspace EAO New

Select Sections for Report

Member . . . . . . . . . . . : ITSCV5R1A

Type options, press Enter. Press F6 to print entire report.
1=Select
Option Section

Component Interval Activity
Job Workload Activity
Storage Pool Activity
Disk Activity
IOP Utilizations
Local Work Stations
Remote Work Stations
Exception Occurrence
Data Base Journaling Summary

TCP/IP Activity
Bottom

F3=Exit F6=Print entire report F12=Cancel
New

New
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Information for each time interval:
Datagrams Received
Datagrams Requested for transmission

Total - total supplied by local IP-user protocols
Discarded - because either no route was found or due to lack of buffer space

TCP Segments per second
Received
Sent
% Retransmitted

UDP Segments per second
Received - UDP datagrams delivered to UDP users.
Sent - UDP datagrams sent by UDP users. 
% Retransmitted

ICMP Messages
Received - by the specific interface.
Sent  - by the specific interface.
% Retransmitted

Terraspace - Effective Address Overflow
Listed in the Exception Occurrence Summary and Interval Counts.  A Terraspace EAO occurs when computing a 
terraspace address that crosses a 16-MB boundary.  Allow for an approximately 1% performance degradation  if 
there are 2,300 EAOs per second. 
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V5R1 support for 

2001 Processor Models, Processor on Demand
V4R4 PTF: SF65568
V4R5 PTF: SF65561
V5R1 PTF: SI01485

More than 2 "supported releases" copy from one CPU to another using when Work with CPUs - 
Copy function 

V4R5 PTF: SF65725
V5R1 PTF: SI01489

 More flexible LPAR modeling for interactive to processor performance rating ratios (cover letter 
documentation)

V4R5 PTF: SF65725
V5R1 PTF: SI01489

For each BEST/1 Workload 
Supports "Processor Efficiency" 

V4R5 STRPFRMON INTDTA(*YES)
V5R1 Collection Services - Enhanced Capacity Planning 

PEX Data - Processor Efficiency 

page93.prz/1
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V5R1 is expected to be the last release to support BEST/1.  The recommendation is to become familiar with the 
Workload Estimator.  Also, we recommend investigating some other capacity planning tool, such as BMC's Patrol.  
Note BMC plans to add iSeries support to Patrol, but as of April 2001, there is no formal announcement by BMC of 
this capability.

Processor Efficiency
V4R5 STRPFRMON INTDTA(*YES)

 Specifies whether internal data is to be collected.  Internal data is collected.  Do not specify *YES for this value 
unless instructed to do so by an IBM representative.   Data may be collected to enhance capacity planning 
capabilities or for other purposes.  It should not be turned on unless you are doing so for a specific purpose.   
This option requires performance monitor to start a Performance Explorer (PEX) collection (session-id 
QPFRMON).  Performance monitor will create a performance explorer definition named QPFRINTDTA.  This 
collection may conflict with other PEX collections.               

              
V5R1 Collection Services - Enhanced Capacity Planning 

PEX Data - Processor Efficiency
This category contains the cycles per instruction for performance explorer (PEX) data. Data may be collected to 
enhance capacity planning capabilities or for other purposes. Special considerations apply when using this 
category A performance explorer definition, QPMIPEXPEI, is created. If a performance explorer definition 
already exists, it is deleted and re-created. This category requires Collection Services to start a performance 
explorer (PEX) collection (session-ID QPMINTPEXD). This collection can conflict with other performance 
explorer collections.  You should not end or start the QPMINTPEXD session manually because this will affect the 
validity of the data collected.  When collection of this category stops, it also ends the performance explorer 
collection for session QPMINTPEXD.

BEST/1 Support
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Workload

Application Type attribute for each BEST/1 workload 
Based on Functions

Based iSeries Jobs included in workload

Change Workload

Workload . . . . . . . : INTCPU
CPU architecture . . . : *RISC

Application type . . . : *MIXED

Type changes, press Enter. Press F13 to specify a single application type for
all transactions.
Workload text . . . . . . Measured from PFR45PFRM (DBCPUID820)
Workload type . . . . . . *NORMAL F4 for list
Usage mode . . . . . . . 2 1=Casual, 2=Interrupted, 3=Steady,

4=N/A
Functions Avg K/T ------Tns per Function------

Function Text per User (secs) Inter Non-inter
Function of INTCPU 1.00 58.7 45.77 138.94

Bottom
F3=Exit F4=Prompt F6=Work with functions F9=Specify chars to comm lines
F10=Specify I/Os to ASPs F12=Cancel F24=More keys
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*MIXED                                                     
    Indicates that there is no single application type for the transactions in this workload.                     
 
Application type                                          
The application type which is common to all the   transactions in this workload.  Descriptions of  individual application 
types are found either in Help for the Select Application Type display accessed by  pressing F4 on this field, or in 
Help for transaction  application type fields.                              
                                                           

Processor Efficiency
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Display Transaction

Workload . . . . : INTCPU Measured from PFR45PFRM (DBCPUID820)
Function . . . . : INTCPU Function of INTCPU

Transaction Type . . . . . . . . : 1 1=Inter, 2=Non
Pool ID . . . . . . . . . . . . : 4
CPU priority . . . . . . . . . . : 20
CPU time . . . . . . . . . . . . : 1466.674 Secs (on B10)
Database time . . . . . . . . . : .000 Secs (on B10)
Permanent writes . . . . . . . . : 63.4 Percent
Chars transferred in . . . . . . : 7670
Chars transferred out . . . . . : 224124
Exceptional wait . . . . . . . . : .0 Msec
Application type . . . . . . . . : *COMPUTE

More...
DB Reads DB Writes NDB Reads NDB Writes

Sync I/Os . . . . . . : .1 .0 17.6 .3
Async I/Os . . . . . . : 19.0 .0 .1 .8

CPU Time
Application Adjustment

Opt Type Factor
_ *DEFAULT 1.00
_ *OLTP .89
_ *GEN_DB .86
_ *EOD_DB .91
_ *GEN_CA .96
_ *COLLABRTV .06
_ *APPSERVER .96
_ *COMPUTE .96
_ *APPLTYPE1 1.00
_ *APPLTYPE2 1.00

Workload Function
Application Type - Example

BEST/1 Application Types
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The name of the application type for this transaction. Every CPU model type has a performance adjustment factor for 
both CPU time and I/O counts for each application type.  These factors are applied when the BEST/1 model is  analyzed.  

*DEFAULT                                                   
This application type is used if no type is specified  or if measurement data does not include application type information.  
CPU service time and I/O counts are  not adjusted for transactions with this application  type. This application type has an 
adjustment factor of 1.0 so that there is no change to the CPU times  or I/O counts.                                                    
                                                           
*OLTP                                                      
On Line Transaction Processing.  This application is  highly interactive, with many transactions of short duration.  It is 
primarily comprised of interactions  with the database and interactions with the end-users'  display.  This category 
includes green-screen interactive applications, simple ODBC and other simple  Client/Access applications, and DDM 
environments that  serve this kind of application.                        
                                                           
*GEN_DB                                                    
Generic Database application.  This is similar to *OLTP, except that it may also include complex transactions and 
background work.  At least some part of this workload does not contain interactive  transactions.  This is the most 
common application type on the AS/400.  It combines transaction processing with batch data base processing and other 
aspects of the AS/400.                                

*EOD_DB                                                   
End of Day Database application.  This application  type covers the situation where a relatively small number of jobs 
process a large amount of data.  It does not have to run at the end of the day.  It just has to use system resources in a 
way similar to "end  of day" or "end of week" applications.  Some query  applications fit this category, as well as 
background  batch jobs and overnight jobs that process data from  an AS/400 database.                                   
                                                            

Application Types
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*GEN_CA                                                     
Generic Client Access application.  This is similar to *OLTP and *GEN_DB, except that more of the application 
requirements are satisfied by client requests to a database server.  Applications that might fit this  type are transaction 
processing using Java, Client/Access using small to medium queries, and Web-based environments.                                
                                                            
*COLLABRTV                                                 
Collaborative processing.  This is typical of but not limited to Domino applications.  The application type can be 
characterized as having a large number of end-user jobs that interact with the system often, but that do not require 
significant use of an AS/400 database.                                             
                                                           
 *APPSERVER                                                
Application Server.  This type of application is  similar to *COLLABRTV, except that a significant  amount of processing is 
required for each interaction  with the user.  There is no significant database  processing. This is similar to many middle-tier        
applications of three-tier environments, where the system spends significant time processing and  formatting information on 
behalf of end-user client systems and primary database servers.                  
                                                           
*COMPUTE                                                   
Compute Intensive application.  This is an environment  where substantial CPU is required for each unit of work.  The 
processor light should be running at or near 100% while processing a request for this kind of  workload.  Some Java-based 
applications fit this  application type, although that is not a prerequisite. 

*APPLTYPE1 and *APPLTYPE2            
 Additional application types     
                                      

Application Types
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Performance monitoring and reporting

Additional cost  

Monitoring support
Similar to  V5R1 Operations Navigator

-Management Central performance, job, and message monitoring

Can combine AS/400 performance monitoring with performance 
monitoring of  other operating systems

Performance reporting similar to combination of V5R1 Collection 
Services Graph History, PM/400 reports and graphics, and 
Performance Tools for iSeries licensed program

Understand: OS/400 no charge Performance Monitors, Graph History, 
PM/400 - additional cost for Performance Tools for iSeries licensed 
program and PM/400 services.  Then consider Patrol for AS/400.  



 8 2001 IBM Corporation

iSeriesIBM serverPatrol for AS/400 - Performance Monitoring
Complements OS/400 Management Central Performance Monitor support
Reports and monitors availability and performance across critical areas of iSeries and 
AS/400 operation 
Issues visual warnings and alarms when thresholds are exceeded 
Enables the event-based triggering of automatic user-supplied recovery or intervention 
actions 
Allows remote, concurrent monitoring of multiple AS/400 systems from a single PATROL 
Console 
Provides a native autonomous agent delivering comprehensive PATROL Agent platform 
support for AS/400 
Allows execution of AS/400 commands and building of sophisticated automatic recovery 
actions 
Provides consistent management across all platforms (iSeries, Unix, Microsoft Windows 
2000, etc.)
Requirements: 

OS/400 V4R3 and above, with TCP/IP configured and running 
PATROL Console on Unix, Microsoft Windows NT or Microsoft Windows 2000 platform 
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Monitoring and Operational Capabilities
System – Overall system-wide metrics, including total and interactive CPU utilization, average interactive response 
time, and transaction rate. 
Message queues – Ability to trap, view, and take action (such as e-mail notification, pager dial, etc.) for messages 
of interest arriving on QSYSOPR or other specified message queues. An auto-reply feature also enables automatic 
answering of inquiry message arriving on the queue. The number of new messages, as well as the number 
currently waiting for a reply, is also shown for each monitored message queue. 
Active jobs – Overall information on the number of active jobs in the system, as well as the ability to monitor 
specific jobs of interest. For each job, the CPU utilization, I/O rate, response time and transaction rate (for 
interactive jobs), job status, and job type are reported. You can configure alarms and specific actions to occur 
when too many jobs exceed a CPU threshold, or a particular job changes from active to inactive status. Reports 
listing jobs utilizing the CPU above a specified threshold or with a status matching a user-specified status list are 
also available. 
ASPs – Information for each configured ASP, including space utilization, I/O rates, I/O sizes, and reports showing 
busy, failed, and all disk arms in the ASP. You can also configure alarms and recovery actions to warn of high 
space utilization or the failure of disk arms in the ASP. 
Libraries – Information on the number of objects in a library and the total size of the library. You can monitor 
individual libraries and configure alarms and actions to be triggered on changes in size or number of objects. You 
can also request reports that show current size and object counts for all, all users, or all IBM® libraries. 
Subsystems – Number of active jobs and subsystem description information for all active subsystems. Subsystems 
can be started or ended. 
Main storage pools – Fault, page, and transition information for each pool. 
Batch jobs – Information on the number of batch jobs running, waiting to run, ending, and held. 
Users – Information on the number of users signed on, temporarily signed off, suspended, and signed off.
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PATROL for Performance Management: 
Collects Performance data similar to Collection Services.
Download summary performance data to client workstation running Patrol 
Visualizer
Visualizer graphically displays various performance metrics per system per day
User can view multiple time periods and can make use of Visualizer Thresholds 
to detect exceptions 
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For additional information on Patrol for AS/400 by BMC Software, refer to:
http://www.bmc.com

Search for "Patrol for AS/400" 
http://www.bmc.com/rs-bin/RightSite/getcontent/bmcdoc.html?dmw_objectid=09003201803d6267&dmw_format=html
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iSeriesIBM serverNotes: Trend Analysis (PM/400)

Selecting Trend Analysis from the Real-time Monitor provides a link to the IBM PM/400 website.  

If the user chooses to view a graph of data that was not in the range allowed, messages will appear suggesting the 
user activate PM/400.

From the PM/400 webpage, click on the button to "View Management Summary Graph".

When PM/400e is activated, the performance monitor samples this statistical data and these values are used to 
calculate an  average hourly utilization. of system resources. These hourly utilizations are then used to calculate the  
monthly (first-)shift average.   

'Peak' utilization which is defined as the worst contiguous 2 hour period is also computed. These values from each day 
of the reporting period are in turn used to calculate the peak average for the reporting month. While many systems 
experience a similar performance profile each day it is also quite common for the heaviest two hour period to be 
different from day to day.
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When you sign-on specifying your iSeries Serial Number and assigned password, you will see the trend in usage of 
your system resources

CPU Utilization
Interactive Workload
Interactive and System Workload
Total 
Disk Space
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Activation
At IPL:

MPH8001 message  to QSYSOPR 
 Respond "G" to activate PM/400e 

At anytime:
Sign on as QSECOFR 
Enter command CFGPM400. 

Typical system setup

After successful activation
(Confirmed by Screen)
Setup items

Type "GO PM400"
Displays PM/400e menu

     Verify option 4 "Work with Contact Information" 
     Check option 6 "Work with PM/400 Customization" 

Starting PM/400

http://www.as400.ibm.com/pm400
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PM/400 Data Integration -- For those users of PM/400e, there is now a direct link from the web based PM/400e data 
collection to the Estimator.   See  http://www.as400.ibm.com/pm400  for more details.  Also, you can check out our 
help text regarding the capabilities and limitations of this feature. PM/400 output should be available by YE' 00.

Multiple existing Systems -- The estimator has been enhanced to include the ability for multiple existing systems to 
be present in an estimation. This will aid you in considering consolidating multiple AS/400 systems into one new 
iSeries 400.   One of  the new tutorials, "Consolidating Existing Systems", deals with this feature.  
Tutorials -- Check out the help drop down.  There are now 5 tutorials available in "PDF" format.  The titles of these 
tutorials are "General Product Walkthrough", "Detailed Walkthrough and Features", "Consolidating Existing 
Systems", "Using Save and Restore" and "PM/400 Integration".   

With V51, PM/400 is shipped as part of OS/400.
   
See the What's New section of the Help text for complete description of the new  functions:

http://as400service.ibm.com/estimator
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You can start and stop PM/400 through Operations Navigator, based on the customization of PM/400. However, 
customization of PM/400 requires interaction with the main PM/400 menu (GO PM400) through a 5250 session.  This 
will allow you to specify:

Limit of your High priority workload               
Days to include in PM/400 Trend Analysis
First shift/Second shift times - these maybe used to specify your period of peak activity and need not necessarily 
coincide with work "shifts".
Location of Performance Collections - defaults to QMPGDATA
Frequency of Purging collections - The  performance data that is collected by the Collection Services monitor 
requires 15 to 35 MB per day.                                                               

 Work with PM/400 Customization

Type changes, press Enter. System: M01
High priority limit . . . . . . . . . 20

S M T W T F S
Trending days . . . . . . . . . . . . 1 1 1 1 1

First shift . . . . . . . . . . . . . 13:00 - 14:00
Second shift . . . . . . . . . . . . . 15:00 - 16:00

Performance data library . . . . . . . PFRV51CS
Performance data purge days . . . . . 10
For second shift reports, contact your IBM Support Team.

More...
F3=Exit F12=Cancel
(C) COPYRIGHT IBM CORP. 1996, 2000
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PM/400 jobs are controlled by automatically scheduled jobs
Q1PPMSUB (hourly)

Ensures Collection Services is collecting data
Q1PPMCHK (4-hourly)

Verifies that data collection is active
Q1PDR (Daily)

Performs Data Reduction
Purges Collection Data

Q1PCM1 (Weekly)
Transmits reduced data to IBM

Q1PPG (Monthly)
Purges reduced datasets from system
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 Work with Automatically Scheduled Jobs
Type options, press Enter.
2=Change
Opt Name Status Next Run Date Next Run Time Runs to Date

Q1PTEST I 02/16/01 12:35 4
Q1PPMSUB A 02/16/01 16:00 5
Q1PPMCHK A 02/16/01 17:45 1
Q1PCM2 I 02/17/01 6:00 0
Q1PDR A 02/17/01 6:00 0
Q1PCM1 I 02/23/01 0:30 0
Q1PMONTH I 03/01/01 0:00 0
Q1PPG I 03/01/01 7:00 0

F3=Exit F5=Refresh F12=Cancel
(C) COPYRIGHT IBM CORP. 1996, 2000

PM/400 Scheduled Jobs
Take option- 2. Work with automatically scheduled jobs to specify the schedules of the jobs that control PM/400 
activity.

Q1PPMSUB runs hourly based on the next run time/date, and starts Collection Services if it is not running. Thus, 
even if you started PM/400 from the Collection Services pulldown menu, at 12:00 noon (PM/400 is started) but 
Collection Services will not start until the time shown in this parameter is reached. 
Q1PPMCHK processes every 4 hours to determine if collection services is running, and issues a message if 
PM/400 is not active.
Q1PDR run daily and performs the following:

Performs Data Reduction
Purges Collection Data

Q1PCM1 runs weekly and transmits summarized data to IBM
Q1PPG runs monthly and purges old reduced data.
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The Workload Estimator is an existing tool that currently helps you size system needs based on estimated workloads 
for specific workload types. We have enhanced the Workload Estimator and PM/400e to work with one another.             
Through a web based application, the enhancements will help you size upgrades to your existing system based on 
PM/400e reported utilization, performance and growth data. This assists you in planning for your future system 
requirements based on existing utilization data coming  from your system. Sizing for additional workload types 
supported by the Workload Estimator (e.g. Domino, WebSphere, Java , and others) can also be included in  the 
sizing. With the flexibility to adjust growth rates and time horizons, the output  will include an iSeries 400 and AS/400 
(170, 7xx, 250, 270, 8xx only) summary level recommendation for your consideration. It will include a suggested 
upgrade for your processor, processor features, memory, disk arms and disk capacity.  This function will be 
accessible while viewing your PM/400e Management Summary Graph. The application does not support an LPAR or 
the processor on demand environment. 

Workload Estimator
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New in  2000.3 version 
Inclusion of the Processor On Demand Models
Updated Workloads

HTTP Workload
Domino Workload 
Java Workload 
 WebSphere Workload 

 Enhanced Save/Restore of Work in Progress 
Portable Document Format Generation

2000.3 version (released Oct 2000)
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Inclusion of the Processor On Demand Models -- With the announcement of the new Model 840 'Processor on 
Demand' models, support for these new  systems is included in the Workload Estimator. There are three new POD 
(processor on demand) processors:

8/12 (eight base processors with four on-demand) 
12/18 (12 base processors with six on-demand) 
18/24 (eighteen processors with six on-demand) 

Updated Workloads: 
HTTP Workload -- The HTTP workload has been enhanced to improve the positioning of the "smaller" systems. 
Domino Workload -- The Domino workload has been enhanced to include the new performance improvement that 
can be realized when running Domino.Doc version 3.0. This update reflects the performance enhancements from 
both specific Domino.Doc improvements as well as an R5 Domino enhancement known to improve Domino.Doc 
Performance. It should be noted that the measurements used for sizing information were taken using Domino 
5.04a. To take full advantage of the performance enhancements represented in the Estimator we recommend 
using 5.04a or later. The Domino Workload help text contains more specific information regarding the Domino.Doc 
application update. 
Java Workload -- The Java workload has also been enhanced for improved positioning of the "smaller" systems. 
 WebSphere Workload -- This workload has been updated to include support for version 3.5 of the WebSphere 
Application Server. 

    
 Enhanced Save/Restore of Work in Progress -- The Workload Estimator now saves individual workloads, in addition 
to the existing ability of saving all the workloads within the estimation.  It also allows the ability to include a single 
saved workload definition into an existing estimation.  The ability to save and restore individual workloads workloads 
enables you to use this as a "copy" function from one estimation to another.  For more details, See the Restore Help. 
Portable Document Format Generation -- It is now possible to have the Workload Estimator generate output of the 
recommended system in the Portable Document Format (".pdf").  This can either be printed immediately, or saved to 
the hard file for later inclusion into e-mails, proposals, etc. 

2000.3 version (released Oct 2000)
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New in  2000.4 version 
PM/400 Data Integration

Customer workload imported directly into Workload Estimator
Multiple Existing Systems

Allows multiple current systems to be considered for upgrade
Assists in Server Consolidation

Direct link from the web based PM/400e data collection to the Estimator
Workload Estimator Tutorials

General Product Walkthrough
Detailed Walkthrough and Features
Consolidating Existing Systems
Using Save and Restore
PM/400 Integration.   

2000.4 version (released Dec 2000)
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With our new connectivity into  Workload Estimator, your PM/400 data can be imported directly into Workload 
Estimator and used to analyze your company growth and AS/400 needs.  Using monthly statistics recorded from your 
system, the Workload Estimator can show system performance trends over time and allow you to more accurately     
determine the growth trends of your company. 

IBM provides a new version of the  Workload Estimator for iSeries 400 3 to 4 times a year. In the 2000.4 version 
(released Dec 2000), we have responded to your requests for various improvements, including the following new 
improvements and features: 

PM/400 Data Integration -- For those users of PM/400e,  there is now a direct link from the web based PM/400e 
data collection to the Estimator.   See http://www.as400.ibm.com/pm400 for more details.  Also,  you can check out 
our help text regarding the capabilities and limitations of this feature. 
 Multiple existing Systems -- The estimator has been enhanced to include the ability for multiple existing systems to 
be present in an estimation. This will aid you in considering consolidating multiple AS/400 systems into one new 
iSeries 400.   One of the new tutorials, "Consolidating Existing Systems", deals with this feature.  
Tutorials -- Check out the help drop down.  There are now 5  tutorials available in "PDF" format.  The titles of these 
tutorials  are 

General Product Walkthrough
Detailed Walkthrough and Features
Consolidating Existing Systems
Using Save and Restore
PM/400 Integration.   

Domino Workload -- The Domino workload has had the questions regarding clustering restructured.  
Internal Improvements -- The Estimator development team is continuously going through the code trying to 
squeeze out  internal performance bottlenecks. 

Workload Estimator Servlet URL: http://as400service.ibm.com/servlet/EstimatorServlet

2000.4 version (released Dec 2000)
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New in  2001.1 version 
OS/400 v5r1 and New iSeries models
MultiSlider Applet 
NewWeb Commerce Workload

WebSphere Commerce Suite version 4.1
WebSphere Payment Manager version 2.2

Removal of WebSphere 2.0x Support
Domino Enhancements
New DSD Workload Calculations
Removal of Domino 4.6 Support 

2001.1 version (released Apr 2001)
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Support for 

OS/400 v5r1 and New iSeries models
MultiSlider Applet 

A new applet has been added to the Domino Workload, Traditional Workload, and Operational Assumptions 
pages to enhance usability. The applet allows  users to answer percentage questions using sliding bars that 
always add up to 100% instead of using individual drop down lists.  

NewWeb Commerce Workload
Replaces the Net.Commerce workload. Previous Net.Commerce workloads that are restored will automatically 
be converted to Web Commerce workloads. This now provides support for: 

WebSphere Commerce Suite version 4.1
WebSphere Payment Manager version 2.2 - Estimates can be sized in conjunction with buy transactions from 
the WebSphere Commerce Suite workload or as a standalone workload.       

Removal of WebSphere 2.0x Support
All WebSphere version 2.0x workloads restored will be automatically converted to WebSphere version 3.02. 

Domino Enhancements
New defaults and assumptions based on feedback on how typical customers are using Domino as well as how 
they are using the Workload Estimator to project Domino workloads. A few of user interface adjustments have 
been made to minimize ambiguity in (a) Domino planned usage and (b) classifying the complexity of a Domino 
user written application. Read the Domino workload help text for a complete explanation of the Domino workload 
enhancements. 

New DSD Workload Calculations
With V5R1 refresh after September 28, 2001, all DSD models  will support Domino Complementary workloads 
such as Java Servlets and WebSphere Application Server.  The  V5R1 Estimator will allow inclusion of 
non-Domino workloads on a DSD as long as the following requirements are met: Domino is the major workload, 
and the  DB2 Universal Database utilization is less than the rated DB2 capacity for that model (15% of the CPU).  

Removal of Domino 4.6 Support 
All Domino version 4.6 workloads restored will be automatically converted to Domino version 5.

2001.1 version (released Apr 2001)
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When you go to the PM/400 webpage at http://www.as400.ibm.com/pm400/ you will see the "hotspot' which offers 
you the opportunity to "Size your next upgrade with PM/400e and IBM Workload Estimator".   This is one of the New 
features of  integration of PM/400 data with the Workload Estimator.   

How do you get to the size?

View  my Management Summary Graph
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Selecting this option from PM/400 takes you directly to the web-based Workload Estimator for iSeries.  Your PM/400 
workload information is automatically associated with the Workload Estimator.

The screen shows your System Name and your Serial Number.

To begin your sizing exercise, click on the button.
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You will be shown an informational screen and a disclaimer, which requires you to accept the conditions prior to 
proceeding with the sizing.  This takes you to the initial screen of the Workload Estimator. 

In addition to the PM/400 measured workload included in the Workload Estimator, you can include additional 
workload to be consolidated on a single system.  These workloads include:

Existing Workloads - allows for entry of measured workloads
PM400-  workload provides a linkage to the PM/400 data that can be automatically collected on your system and 
sent to IBM. You can include multiple PM/400 data collections in a single WLE model to review the impact of 
Server Consolidation. There are two ways to get PM/400 data into the Estimator.

1.Start at the PM/400 website. Please see http://www.as400.ibm.com/pm400/ for more information. 
2.Go back to the Workload Selection screen and "Restore" a set of PM/400 data that you previously saved. 

Domino
Java
Web_Commerce
Traditional
WebSphere
HTTP
Generic

The initial window allows up to three workloads to be defined.  If additional workloads are required, select the "Allow 
Another Workload" button.     
Use the Options tab from the Edit pulldown menu to specify  the Basic calculation defaults  (RAID/Mirrored, DBCS 
etc) as well as system selection criteria ( resource utilization limits using "slide bars" for Total and Interactive CPU, 
disk etc). 
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The period 
over which 
performance 
data was 
used to 
determine 
growth 
estimates.
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As you navigate in to  the PM/400 workload, you will see the information carried in by PM/400, shown as defaults.  
This includes:

Machine Serial Number
Model/Feature
System CPU Utilization and the total CPW rating of the system
Interactive CPU Utilization and the interactive CPW capacity of the system.
Number of Processors
Installed Memory
Number of Disk Arms and the measured arm utilization
Disk Storage (space) installed, and space utilized in GB and as a percentage
Disk protection (if any)

If you wish to consolidate PM/400 data from multiple iSeries or AS/400 systems, you can include multiple PM400 
datasets. 
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The lower portion of the panel indicates the growth rates determined by examining PM/400 data collected over a 
period of time.  You can manually override these estimates.  These are the growth rates that will be used to establish 
the growth in hardware resource requirements. 

Months to Grow - represents the planning horizon for this sizing exercise.  You can plan up to 36 months with the 
Workload Estimator. 

The growth estimates for the following hardware resources are included:
CPU - measured as CPW per month

Interactive 
Non-interactive

Disk Arms - measured as Arms per month
Disk Storage (space) - measured as GB per month
Memory - MB per month, if you choose to grow memory independently.  However, you can choose to grow 
memory in line with any of the other resources.  In this case, you should select the appropriate radio button. 
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Selecting the "Advanced Growth Options" will allow you to better identify growth rate projections.  

For each of the growth parameters, a graph can be displayed showing the points measured in the PM/400 data 
collections.  You can use this to choose which particular measurement points are to be used in determining a trend.  
For example, in the chart, the Workload Estimator has included all points of the data collected (10 months) and 
determined a negative growth rate (-0.12) based on "least-square fit".
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(advanced-2)

The applicable growth rate can be modified. For example:
if you deselect all the periods, except  month 6 and month 3
it would modify the rate of growth to +4.199. 

Similar changes can be made for all resource metrics. 
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This display shows an example of how to define an additional Java workload to be implemented at a the beginning of 
the time period under review.   The specification include:

Maximum number of Java users
Users generating constat work
Estimating of the complexity of workload
Additional Java batch workload
etc.



 8 2001 IBM Corporation

iSeriesIBM serverWorkload (Existing-manual input)



 8 2001 IBM Corporation

iSeriesIBM serverNotes: Workload (Existing-manual input)
This display is an example of how you can define an additional "Existing Workload" based on performance 
measurements of another system.  You will be required to specify:

the system model and feature (select from the pulldown menu)
the measured total CPU utilization
the measured interactive feature utilization
memory installed
disk installed - number of arms
disk storage (space) installed - GB
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In the prior version of the Estimator, the user could opt to select a "Typical Setup" which represents  use  of Domino 
as an e-mail system and an application server.  The Typical Setup for Domino consists of Mail and User Written     
Applications.  Typical Setup is the default choice that is designed for first time users of Domino.   This option has 
been removed. 

The use has to select the Domino workload from 
Applications: 

If you decide to use Domino only as an application server 
Mail:

If you decide to use it only as an e-mail system    
Domino.Doc  application:

     possible to select several uses together. 
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The Domino workload allocation between casual, moderate d heavy concurrent mail users is now input using a 
slide-bar, representation 100% of the users.  In the previous version of the Estimator, the user had to ensure the total  
percentages added up to 100%.

This same "slide-bar" is used in specifying the concurrent user distribution for Domino Document Definition workload.
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This panel allows you to specify which of the current systems (iSeries or AS/400e) you would like to have considered 
as a candidate for hardware upgrade.  This  preference could be as a result of factors other than hardware 
considerations, like financial issues related to a current lease on equipment. 
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The Workload Estimator will make a suggestion on hardware requirements based on the workloads included in the 
profile and the estimated rates of growth of the resources.    A recommendation for an immediate and "growth" 
solution are provided. 

A capability to produce a .PDF file has been included in addition to the print option.  
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Facts

High density drives reduce CPU 
performance when same total disk 
capacity is maintained, i.e. fewer disk 
arms

Disk arms define performance - not disk 
capacity 

Disk size

Disk capacity

4G
B 8G

B

17 G
B

2G
B

Challenge

avoid disk constraint installations due to 
dramatic reduction in the number of disk 
drives as high density drives and/or disk 
compression became available

The need to properly position the  high density 
(18GB, 35GB (future)) and high RPM (10,000 
rpm) disks 

Estimating number of disk arms 
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Disk Arms Considerations White Paper
widely used in the field for 3 years  

key document in selling additional DASD arms  

Requires:
some technical skills  

time for manual calculations

Automated calculations:
very fast - estimated usage time 
about 5 minutes 
no need for technical background
work in progress ...

Estimating number of disk arms solutions
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Easy to maintain
Easy to keep current

Required input
- CPU Model
- Processor Feature
- Interactive Feature
- IOA/IOP Type
- Protection Method
- Proposed DASD Device

Output
- number of disk Arms required to insure 

that CPU will not wait on disks 
The ODAC tool and white paper may be found 
through the System Performance web site at::

http://www.ibm.com/eserver/iseries/perfmgmt/
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Tool Answers question Primary 
use Required input Output Estimated 

time to use

ODAC
What number of disk 
arms are needed to 
avoid having the CPU 
waiting on the disks?

New sales / 
upgrades

Focusing on 
disk arms

CPU Model 
Processor Feature
Interactive Feature
IOA/IOP Type
Protection Method
Proposed DASD Device

Number of disk arms 5 min

Workload 
Estimator

What is the minimum 
number of disk arms 
required for good 
performance on a 
specific and known  
workload? 

New sales / 
upgrades

Focusing on 
workload

Input can be from one of 
these sources:

PM/400e data
Model and CPW
Workload parameters for 
Domino, Java, or 
WebSphere

- Model, feature, 
memory
- Number of disk arms
- Total disk
- CPU % utilization
- Growth projections

5 - 20 min

BEST/ 1

* BEST/1 will 
not be  
supported by 
IBM after 
V5R1

What is the number of 
disk arms needed in a 
complex configuration 
environment and for 
actual workload running 
on iSeries or AS/400

Upgrades 

BEST/ 1 is 
intended for 
the use of  
experts  
knowledgea
ble in 
performance 

CPU model
Processor feature
Interactive feature
IOA/IOP type
Number of arms
Protection method 
Measured performance 
data 

Proposed device 
features

Proposed growth rates 
Compression information

- Disk features 
- Total disk utilization 
- CPU % utilization 
- IOA/IOP % utilization 
- MSecs per I/O 
- Communications 
- Growth projections

Depends on 
the user 
experience .  
Can span 
from 30 min 
to a week.
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